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Introduction

AssetTracker is a desktop database application for MS Windows based PC's for recording the
current location of Assets belonging to a company, office or department.

An Asset in this instance may be any physical object you do not want to lose. It could be
items of furniture, tools, safety equipment, computer equipment, bunches of keys or even
cars.

The system relies on each asset having a unique code. Ideally each asset will have a barcoded
label stuck to it containing this code, as the system can utilise a hand-held barcode scanner
and/or a portable data collection terminal (PDT) for speedy and accurate handling of asset
movements.

Each asset is recorded in the database with its current Custodian (the company or department
who is responsible for it), current Location, and current Contact (the person who is
responsible for it).

Often, assets such as tools and keys are issued and returned to a central location (checked
out and in). AssetTracker allows this to be done easily by allowing a 'System Owner' and
'System Location' to be configured, and functions are provided to check items out from and in
to this location with the minimum of effort.

AssetTracker records the history of the movement of assets from the day they are created in
the system.
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Whats New

Ver 1.25.0 07/06/2017

1. Added PDT option for Asset Check Out 'Use default contact location' to save having to
select the custodian and location each time.
2. Added PDT option for Asset Check Out 'Prompt for Reference' so it does nor ask for a
reference each time.
3. Added PC option for Asset Check In and Out 'Prompt to print check in and check out report
each time'. Some users never want the report so this was annoying.

Ver 1.24.6 09/03/2017

1. Added a separate Asset Check Out / Check In client for simple data entry.
2. New Report – Assets checked out by product group.
3. Special decoding of QR Codes for contacts/operators.
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Getting Started

Please refer to the CE PDT Installation Guide for information on installing the software and
drivers necessary to run this system.
Start the program either by clicking on the AssetTracker icon on the desktop, from the
Windows start menu.

Logging On

By default, when the system is first installed, there is only one Operator called Administrator.

The Operator Code is Admin 
The Password is Admin

This operator has full control of the system (security level 5), so after logging on the first
time, we recommend you change the Operator Code and/or Password of this operator.

See Operators on how to do this.

Important Note: You must always have at least one Operator with security level 5, as only
they can add or edit the operator list. Do NOT lose the Operator Code and Password of all
your level 5 operators!

When you first start the program, when you try to run any important function, or when you
click on the you will be prompted to log on (if you are not already).
You can log off by clicking on the Log Off button on the main window, or by closing the
program.

What Next

After logging on for the first time, and before adding any assets, you should perform the
following functions:

Add Operators

Add the System Owner, Location and Contact by adding as a Custodian

Set the system Options

Add Product Groups and Products.

...... Now you can add Assets.
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Using the PC Program

The Main Menu

There are buttons on the main window for the most frequently used functions.
All these functions, and some others are also available on the menu at the top of the window.

The name of the database currently in use is displayed in the title bar.

The yellow area labeled 'There are current Alerts' will only be visible when there are alerts to
be actioned.
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Options

From the main window, select Tools / Options from the menu at the top.

A window will appear with 4 tabs of options.

System Options

The System Owner, Location and Default Contact is usually the Owner and Operator of
the AssetTracker database system.
Click on the button with the little hand to select the Custodian, Location and (default) Contact
for the system from the list of available Custodians. Obviously, to do this you would need to
have created the Custodian, Location and Contact first.

Store System Owner in the Database
If this option is checked, the selected system Owner, Location and Contact are stored in the
database, rather than on the local PC. This means that any PC's accessing this database will
(and must) have the same system owner.  
Check this if you have several different AssetTracker databases, as the system owner is likely
to be different for each.
If you only have one asset database, leave this unchecked.

The Asset Label Title is the text that would print on the top of asset label if you were to
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print labels from this system.
See Label Printing for more information.

User Assigned Field Names. Asset records have eight text fields than can be used for
whatever purpose you like. For example, you may want to use one for purchase price,
purchase date, or supplier name. This option allows you to name these fields, and these
meaningful descriptions will then appear in grids and reports.
Note: User fields 7 and 8 are special, in that they can optionally be populated with data from
the PDT during a PDT Asset Audit. 
Field 7 will hold the Addition Info relating to the asset condition if this data is collected
during the audit.
Field 8 will hold the free text entered on the PDT if a new item is added during a PDT Asset
Audit.

If Automatically allocate asset codes is checked, when new assets are added, the system
will chose the next available asset code (an 8 digit numeric code starting at 00000001).
If your assets are already numbered, or you are applying pre-printed labels then it would be
best to leave this option unchecked.

Default Alert Days Ahead and Time allow you to create alerts quicker by not having to
enter the date and time every time. This may be useful if assets should always be expected to
be returned in seven days for example.

Show current alerts can be checked to reduce the number of alerts displayed to only those
that have expired.

Asset Check Out Options

If you regularly check out assets to the same location, you can check the Use Default 'Check
Out To' Values box and select the default values by clicking on the button with the hand.
This saves you having to select the values each time.

Allow Check Out From Other Location, when checked, will not stop you checking out an
asset that is recorded as being elsewhere.
Normally you would only check out an asset that is in the location where the system is.

Sort location in the order they were added, when checked will display locations for the
selected custodian in the drop down box of the Check Asset Out windows in the order they
were added (most recent first), and with the most recent one selected.
If not checked, they will display in alphabetical order with the default location for the
custodian selected.
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Prompt to print check in and check out report each time. If this is checked (default),
when the Check Asset In or Check Asset Out window is closed the system will ask if you want
to print a report of the assets changed during the session. If you don't want it to ask, uncheck
this box. You can always print the report using the 'Print' button in the window before closing
it. 

Environment Options

Maximise all windows. Check this to have the program fill your whole monitor, else the
program will open at it default size of 800 x 600 pixels.

Disable sound. Check this to stop warning beeps sounding when errors occur during Check
In and Check Out. Useful if you are in a library or if it is annoying your co-workers.

Save Asset Grid Settings. In the grid that displays the list of Assets, it is possible to drag
the columns around and resize them as required. It may be that you want UserDataField2 (or
whatever you have renamed it to) to the left of the grid. You can drag it there, and if this
option is checked, next time you open the Asset window, it will still be there. 

Show Custom Logo on Main Window
If you would like to display you company logo or any other picture on the main Window of
AssetTracker, then check this box.
Click on the Select Logo File button to select a .BMP image file of 260 x 120 pixels to
display.

Report Printer. Select your default A4 report printer from the drop down list which will show
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all the printers currently installed on your PC.

Label Printer. Select your dedicated label printer (if you are using one) from the drop down
list which will show all the printers currently installed on your PC.

Label Format Filename. If you are printing labels from the AssetTracker system, select one
of the options available for the label format and size. There are 6 standard sizes available,
four designed for dedicated label printers, and two that allow printing to Avery type A4 sheets
of labels (available from your local office supplies shop). If the label size and format you
require is not available from the list, talk to your AssetTracker supplier about having a custom
label format created for you.

Preview Before Printing. When checked, the label or report will be displayed on the monitor
before printing. This also brings up the printer dialog box which allows you to print only
selected labels or pages, or select a printer other than the default. May be useful for saving
paper.
If you wish to email or save reports in PDF format, this box must be checked as these options
are only available in the report preview window.

Custom Reports. If custom reports have been created specifically for you to replace the
standard 'Check Out' or 'Assets Changed' reports, then check the appropriate option.

Default File Paths. If regularly importing or more likely exporting data (in CSV or PDF
format), having these options set saves you having to select the path where the files are to be
saved each time.

PDT Options

Hide all PDT functions. If you are not using a PDT, check this box to hide all the related
functions and therefore avoid selecting them by accident.

Set ActiveSync to Guest Only. When checked, this stops an annoying window popping up
each time your PDT is connected. Uncheck it if you use other Windows Mobile devices on your
PC, or if you like annoying windows popping up.
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Operators

This function displays the list of Operators in the database.
From here you can Add Edit and Delete Operators.

For a description of how to use the grid, navigator, locate, search, filter and Show All
buttons, please see Useful Tips. 

By default, when the system is first installed, there is only one Operator called Administrator.

The Operator Code is Admin 
The Password is Admin

This operator has full control of the system (security level 5), so after logging on the first
time, we recommend you change the Operator Code and/or Password of this operator.

Important Note: You must always have at least one Operator with security level 5, as only
they can add or edit the operator list. Do NOT lose the Operator Code and Password of all
your level 5 operators!

Click on Add to create a new operator or Edit to modify the currently selected operator record
in the grid:

The operator code must be unique, but can be any alphanumeric string.
It could be an existing employee number, or you can just make something up.
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This operator code is required, together with the password, when logging on.

The name is for display purposes only.

The security level restricts access to some functions and ranges from 1 (operator cannot do
much) to 5 (operator can do anything).

Level 5 - Has full control of the system.
Level 4 - Cannot delete data
Level 3 - Cannot delete or edit data
Level 2 - Cannot delete, edit, check in/out or use the PDT functions (basically view data and
reports only).
Level 1 - As level 2 currently.

Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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Custodians

This function displays the list of Custodians in the database.
From here you can Add Edit and Delete Custodians.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

A Custodian may be a company, department or other entity responsible for the assets.

The 'system owner' (see Options) is the Custodian who would normally be the operator of the
AssetTracker system.

Each Custodian must have one or more Locations and each Custodian must have one or more
Contacts.
click the Locations or Contacts buttons on the right to Add, Edit, Delete or view the
Locations or Contacts for the Custodian currently selected in the grid.

In the example in this documentation, there are three Custodians. 
The 'Department of Buildings' is the system owner and they own bunches of keys that are
sometimes transferred to locations within the 'Department of Buildings' and sometimes to
locations belonging to other custodians such as the two security companies listed. 
 

Click on Add to create a new Custodian or Edit to modify the currently selected Custodian
record in the grid:
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The Custodian Code must be a unique (within Custodians) alphanumeric string.
Maybe a code for this entity already exists, or you can make one up. In the example, the code
starts with C just to distinguish it from asset or any other code numbers used.

The notes field is a free text area where you can enter any text you like that relates to the
custodian.

Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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Locations

This function displays the list of Locations associated with the selected Custodian (whos name
appear in the title bar).

From here you can Add Edit and Delete Locations.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

In the example in this documentation, there are four Locations for the selected Custodian
(Department of Buildings).

Click on Add to create a new Location or Edit to modify the currently selected Location record
in the grid:
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The Location Code must a unique (within Locations) alphanumeric string.
Maybe a code for this location already exists, or you can make one up. In the example, the
code starts with L just to distinguish it from asset or any other code numbers used.

The notes field is a free text area where you can enter any text you like that relates to the
Location.

Each Custodian has one Default Location. This is used to speed data entry when checking
out Assets. Check this box to set this Location as the default.

Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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Contacts

This function displays the list of Contacts associated with the selected Custodian (whos name
appear in the title bar).

From here you can Add Edit and Delete Contacts.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

In the example in this documentation, there are three Contacts for the selected Custodian
(Department of Buildings).

Click on Add to create a new Contact or Edit to modify the currently selected Contact record
in the grid:
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The Contact Code must a unique (within Contacts) alphanumeric string.
Maybe a code for this Contact already exists, or you can make one up. In the example, the
code starts with CN just to distinguish it from asset or any other code numbers used.

The notes field is a free text area where you can enter any text you like that relates to the
Contact.

Each Custodian has one Default Contact. This is used to speed data entry when checking out
Assets. Check this box to set this Contact as the default.

Each Contact has one Default Location. This is used to speed data entry when checking out
Assets. click on the button with the hand to select the default location for this contact.

A contact record may be created by scanning a Driving Licence or similar using a CardScan
device if the module is installed.
The image on the right is of a scanned licence. 
Any image may be assigned to this contact record by clicking on the 'Select Image From File'
button and selecting an image in .BMP (Windows Bitmap) format.
See CardScan section of help for more information.

Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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CardScan

CardScan is a USB connected device that can scan an image from a driving licence, boat
licence or similar ID card and extract the necessary contact information from it to add to the
database.

The information required is :
 The licence number (which can be used as the Contact ID).
 The contact name
 Up to 4 lines of address information

If set up correctly this can greatly reduce data entry time when adding new contacts.

Different Licence Types will have the required information in different locations on the card,
so the system must to configured for the most common card types you will be scanning.
The list of cards configured for your system can be viewed and modified from Tools /
CardScan Licence Type List on the main menu.

See CardScan Licence Type List for details.

When scanning a licence, select the card type from the drop-down list, and the number, name
and address should be automatically read from the card into the correct fields of the 'Add
Contact' screen. 
See Scanning a Licence to Add a Contact for details.

The images of scanned cards are also stored for reference. 
See Image Storage for details.
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CardScan Licence Type List

Select Tools / CardScan Licence Type List from the main menu to view the currently
configured card types.
We need to know the coordinates (location) of the licence number, name and address on the
card so when any card of this type is scanned, the system can automatically pick out this
information.

Click on Add to create a new entry. You will be prompted to enter a description for this card
type:

A grid will be displayed where the coordinate information may be entered:
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If you know what the correct coordinates are (because someone has told you), you can key
then in manually.
If you have a real card, you can click on 'Scan Licence to Acquire Coordinates' and feed the
card through the scanner.

When the scan is complete, a window will appear with drop-down lists for each required field.
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The drop-down lists contain all the different bits of text that the scanner has read from the
card, together with its coordinates.
In the first box, select from the list the line which contains the Licence number.
In the second box, select the line containing the licence holders name.
In the thrid box, select the first line of address etc...
If there is no address line 2, 3 or 4, leave the fields blank.

Press OK when finished.
The coordinates will be transferred to this screen:
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Click OK again to save. This licence type will now have been added to the list.
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Scanning a Licence to Add a Contact

When you want to scan a Licence or other card type to create a contact either from 'Add
Contact' or 'Check Out',  this window will appear:

Select the kind of licence or other ID card to be scanned from the Licence type drop-down list.
This list contains all the licence types configured on th system (see CardScan Licence type List
for details).

Next, click on the Scan Licence button and feed the card into the CardScan device.

The system will read the information form the card and display it:
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If the fields are blank or in the wrong places, it may be that the wrong licence type was
selected. You can change the licence type from the drop-down list until you find the right one.

At this point you can check that the correct details are in the correct fields, and that the
numbers and spelling are correct.
The data can be edited here if necessary.

Select OK when the data is correct.
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Image Storage

The images scanned by the CardScan device are not stored in the database itself, but as .BMP
(Windows bitmap) files in a sub-directory of the directory (folder) where the database file is
stored.
The sub-directory itself is the name of the database with _images appended.

For example, if your database file is C:\MyDatabases\AssetTracker.mdb
The image files for that database will be found in C:\MyDatabases\AssetTracker_Images

Each image file has the name of the Contact ID (as it must be unique within each database)
with a .BMP extension.

Note: Only the last image scanned for any contact is stored. If a contact presents a licence or
ID card for scanning again, any existing image for this contact will be overwritten.
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Products

The AssetTracker database contains a list of products. For example a bunch of car keys, a
bunch of office keys, a mahogany desk or a glass coffee table.

The list of Product Groups can be used to organise these products, rather than having them in
one long list. 

You may have many assets that are the same product (e.g. 20 glass coffee tables). Having a
product list helps reduce the amount of data entry required when adding assets to the
database. Have a list of product groups, makes it easier to find the required product.

This function displays the list of Products. 
From here you can Add Edit and Delete Products.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

The grid shows a list of products contained within the Product Group displayed at the top of
the window.
Select the required Product Group from the drop down list.
To add a new Product Group, you can click on the Groups button.

Click on Add to create a new Product or Edit to modify the currently selected Product record
in the grid:
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The Product Code must a unique (within Products) alphanumeric string.
Maybe a code for this Product already exists (supplier or manufacturer code for example), or
you can make one up. 

The Manufacturer field can be used if required, but is optional.

For some assets it may be a requirement to store a serial number, in this case, check the 
Serial Number Required box then you can enter a serial number for all assets of this
product type.

Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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Product Groups

The AssetTracker database contains a list of products. For example a bunch of car keys, a
bunch of office keys, a mahogany desk or a glass coffee table.

The list of Product Groups can be used to organise these products, rather than having them in
one long list. 
For the above example you could create groups for these products called 'Keys' and
'Furniture'.

You may have many assets that are the same product (e.g. 20 glass coffee tables). Having a
product list helps reduce the amount of data entry required when adding assets to the
database. Have a list of product groups, makes it easier to find the required product.

This function displays the list of Product Groups.

From here you can Add Edit and Delete Product Groups.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

Click on Add to create a new Product Group or Edit to modify the currently selected Product
Group description in the grid:
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Click on OK to save the changes to the record, or Cancel to abort.

For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 
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Assets

This function displays a list of all the Assets in the database.
From here you can Add Edit and Delete Assets, print labels and reports and add alerts for
assets.

For a description of how to use the grid, navigator, locate, search and filter buttons, please
see Useful Tips. 

Click on Add to create new Assets (see Adding Assets) or Edit (see Editing Assets) to modify
the currently selected Asset record in the grid.

When you Delete an Asset, you will be prompted to select a Reason for Asset Deletion. 
For an explanation of Show Deleted and the Delete and Undelete buttons, click here. 

Alerts can be allocated to assets to indicate when an something relating to an asset needs to
be done. Click on the Alerts button to show alerts for the asset currently selected in the grid.
See Alerts.   

The History of an asset can be viewed and printed, showing all movements of the asset and
other events in its life. See History.

A report of all the current assets in the grid can be printed, using the Print Asset List button.
Note that the number of assets in the grid can be reduced or 'filtered' by various criteria by
using the Filter button. See Useful Tips on how to do this.
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The details of the assets currently displayed in the grid can be saved in CSV (Comma
Separated Value) format by clicking on the Save as CSV button, and entering a filename.
CSV files may be opened in MS Excel.

For an explanation of the Print One Label and Print All Labels buttons, click here. 
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Adding Assets

When adding an asset, this window will have the Custodian, Location and Contact fields set to
the System Owner, Location and default Contact set in System Options, as generally when a
new asset is created, that is its location. However these values can be changed if the asset is
with a different custodian, location or contact by clicking on the appropriate selection button.

Select the Product by clicking on the selection button under the word Product. 

Enter any values you require in the 14 user data fields. note that the description of these
fields can be whatever you like (in this case two of them are labeled 'Building Name' and Nb
of Keys') and is set in System Options.

Enter and notes you want to relate to these assets.

The Condition field allows you to select from a list of Asset Conditions that you can create, for
example 'OK', 'Slightly Damaged' or 'Unrepairable'. 

The Reference field allows you to select from a list of References or Job numbers. This can be
set when an asset is checked out and is cleared when the asset is checked back in.

The three link fields can be used can be the name of an image file (.jpg, .bmp etc.),
document file (.doc, .xls, .pdf etc.), or any other file type that Windows recognises). You can
even enter a web site that relates to the asset. 
Either type the filename (with full path) or website link directly into the edit box, or use the
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button with the hand on it to select the relevant file.
When the 'open link' button is pressed the link will be opened using the appropriate program
(as defined in Windows for a file with that extension).

Now you are ready to create one (Add One) or more (Add Many) asset records with these
details in the database.

An Asset Code uniquely identifies a particular asset. Generally this number is printed on a
label attached to the asset and encode in a barcode on the label.

Note that how the Asset Codes are allocated depends on whether the Automatically allocate
asset codes box is checked in System Options.

Automatically Allocated Asset Codes

If the Automatically allocate asset codes box is checked, the system will automatically
allocate asset codes.
The codes will be 8 characters long and numeric with leading zeros. 
The first code allocated will therefore be 00000001, the next 00000002 etc. The system will
allocate the next one available.

If you click on the Add One button, you will be prompted to confirm that this what you want
to do:

After clicking Yes 

it will tell you which asset code was allocated, and the asset will now appear in the main
Assets grid.

If you click on the Add Many button, you will be asked how many assets records you would
like to add:
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Enter the number and click on Ok. After confirming it will create these records, all with the
same product, custodian etc, and let you know the result:

The assets will now appear in the main Assets grid.

Manually Allocated Asset Codes

If the Automatically allocate asset codes box is NOT checked, you must enter your own
asset codes.
This is useful if you already have asset codes allocated to assets, or you have pre-printed
labels with codes on them.

If you click on the Add One button, you will be asked to enter the Asset Code:

After confirming that this is what you want to do, it will tell you if it was successful:
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If you click on the Add Many button, this window will appear:

This allows you to enter a range of codes. 

Note: The prefix field is optional
Note: The suffix From and To fields must be numeric.

For example, if you have codes from AB00004 to AB00047, you could:

set the Prefix to AB
set the Suffix From to 00004
set the Suffix To to 00047

and click on Ok.

It will ask you if you want to continue:

If you say Yes, it will confirm whether it was successful.

A record of when each asset is added to the database recorded as part of its history.
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Editing Assets

This window can be used to change any of the asset details.

It is unlikely that you would need to change the product or serial number. This should only
need to be done if an error was made when creating the asset in the first place.

The custodian, location and contact responsible for the asset can be changed here, as well
as the notes and links.

The asset code should only need to changed if its label has fallen off or if it becomes
unreadable. Generally an asset would have the same code for its entire life.

A record of when each asset is edited is recorded as part of its history. 
This history record contains the new product, custodian, location and contact but not the user
definable field information or notes.
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Asset Condition

Each asset has a field describing its condition.
Select Database / Asset Conditions from the main menu to maintain a list of conditions.

During an asset audit on the PDT, you can optionally prompt to select the condition of the
asset from a drop down list which will display the options entered here.

If the Prompt for Additional Info box is checked for the condition selected, you can also
enter some text on the PDT during the audit to better describe the condition.
When the audit data is uploaded, this text will be transferred to the User Assigned field 7 of
the asset record.
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Asset Reference

When an Asset is Checked Out it can be allocated a reference number.
This could be a job or contract number, or could represent a vehicle or other sub-location.
While the asset is checked out, this code will be displayed in the main Assets grid so you can
filter the grid to display all assets with the same reference for example.
NOTE: When an asset is checked back in, this field is cleared but a record ofd the reference
allocated is recorded in the Asset History.

Select Database / Asset References from the main menu to maintain a list of references.

The reference must be added before the asset is checked out, but if checking out assets from
the PC (rather than the PDT), you can access this list from the Check Asset Out window.
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Reasons for Asset Deletion

When an Asset is deleted, the system will prompt for a reason for that deletion.
The reason can be entered at the time or from Database / Reasons for Asset Deletion from the
main menu.
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Alerts

This window lists all alerts for the current asset.
Note that the Enable Alerts box must be checked (see Editing Assets) for alerts for this asset
to become active.
Alerts can be used for a variety of reasons such as to indicate that an asset requires
maintenance, that it is overdue for return or that someone else wants it when it is returned.
We call these different reasons Alert Types and you can add your own. See Alert Types.

In this example, the asset 00000001 is due for return on the 27/09/2008, requires
maintenance on 29/11/2008 and 19/05/2008 and must be scrapped on 26/10/2009.

The operator will be alerted to all these events on the Alert Date by the yellow bulb on the
View Current Alerts button on the main window. See View Current Alerts.

If the alert is enabled to Popup On Check In/Out than the operator will be warned when the
asset is scanned in or out at the time they have it in their possession.

Click on Add to add a new alert for this asset, or Edit to change the alert currently selected in
the grid.
Delete will remove the alert completely.

When adding an alert, select the Alert Type from the drop down list, 
select the date that the alert is to become active,
enter any notes you want displayed when the alert is activated,
and click on OK to save it.
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Alert Types

This window shows the available alert types.
You can add as many as required. There are three in this example.

Click on Add to create a new Alert Type.

An alert type consists of some text explaining what the alert is for, and two 'popup' options.

An alert can be displayed when the date of the alert is reached, 
or it can popup when the asset is checked in or out (or both).
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View Current Alerts

If someone is logged on and the Current Alert panel is yellow, there are current alerts, i.e.
alerts where the alert date is on or before today.
Clicking on this button will tell you how many alerts are current:

This will also pop up when an asset is checked in or out, if there are current alerts for that
asset.

If you say Yes, it will display the current alerts:
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The grid on the left shows the current alerts. The notes on the right are the notes for the
selected alert.

Click on Edit to change the alert - perhaps change the date, edit the notes or even change
the alert type.
Click on Delete to remove the alert.
Click on Close to leave as they are. The alerts will still be current.

Right click on a particular alert in the grid and an option to View Asset Details will appear.
This will allow you to see what the asset is,  who the current owner is etc.
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View All Alerts

This function is available from the main menu by selecting Database / View All alerts.

All the alerts in the system (past and future) wll be displayed in a grid.

The grid on the left shows the alerts.
Those that are current (i.e. where the date and time is in the past) are shown in yellow. 
The notes on the right are the notes for the selected alert.

Click on Edit to change the alert - perhaps change the date, edit the notes or even change
the alert type.
Click on Delete to remove the alert.
Click on Close to leave as they are. The alerts will still be current.

Right click on a particular alert in the grid and an option to View Asset Details will appear.
This will allow you to see what the asset is,  who the current owner is etc.
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History

This function shows the history of the currently selected asset. In this example, Asset Code
00000006.

At the top of the window, the current asset details are displayed.

In the grid is a record for each transaction made for this asset.

For a description of how to use the grid, navigator, locate, search, filter and Show All
buttons, please see Useful Tips. 

In this example, it shows that the asset was added on 14/03/2008, manually edited the same
day (custodian name was changed), checked back in to the Dept of Buildings on 21/03/2008
and then checked out to Aarvark Security.

Click on Print to view (if Preview Before Printing is checked in Options), and / or print the
history report for the asset.
It will look similar to this:
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There are currently 11 different audit transaction types:

Add
Edit - Manual
Edit - File Import
Delete
Undelete
Check In
Check Out
Audit - Ok (PDT function)
Audit - Wrong Location (PDT function)
Audit - Location Changed (PDT function)
Audit - Added (PDT function)
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Check Asset Out

The Check Asset Out function is used when issuing an asset from the default System
Location to another Custodian or Location.

The System Owner (Custodian) and Location are displayed at the top.

 

If you know the code of the person (contact) you are issuing the asset to, enter it (or scan the
barcode) in the Contact Code box. If it is valid, the Custodian, Location (the default location
for this contact) and Contact boxes will be automatically filled.  

You can also scan a Driving Licence or similar if the CardScan module is installed, to read the
contact details from it. See CardScan for details.

If the contact code entered is not found in the database, you will be asked if you would like to
add the contact now. After selecting the custodian that the contact belongs to, the other
contact details can be entered and saved.

If you do not know the Contact Code, you can select the Custodian, Location and Contact
from the drop-down lists.

If you select the Custodian the asset is to be checked out to, the Location and Contact fields
will be filled automatically with the default Location and Contact for that Custodian. These can
be manually changed if required.
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If required, you can assign a reference or job number to the asset being checked out by
clicking on the button to the right of the word 'Reference'.
You can then select a reference from the list or add a new one. See Asset Reference for
details.
This selected reference will be assigned to all assets checked out during this session. You can
change the reference before checking out another asset, or close and reopen the window to
clear it. 

The asset code to be checked out can then be entered (or scanned using a hand-held
scanner).
The current details of the asset will be displayed, and the Custodian, Location and contact
changed in the database to the new values.

 

For speed when checking out many assets to the same location, the Asset Code field is then
selected for the next item.

Note that an error will be displayed if the asset is not currently recording as being at the
System Owner and Location (you can't check it out if it's not here).

When an asset has been successfully checked out, the Add Alert button becomes active (if
alerts are enabled for this asset). If required you can then add an alert such as 'return date',
so you will be reminded if it is overdue.

Either when the Print button is clicked, or when closing the Window*, and assets have been
checked out, the system will ask if you want to print a report of all assets checked out for that
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session (i.e. Since the Check Out window was opened).

* You can stop it asking if you want to print the report each time by unchecking the Prompt
to print check in and check out report each time option in the Asset Check Out Options.

The report printed will show the date and time, and a list of assets checked out together with
who they were checked out from and to.

If for example you check out 5 tools to Fred, he can take with him a hard copy of what he was
issued.

A report on what was checked out by date and time can also be printed from the Main Menu -
select Reports / Assets Checked Out.
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Check Asset In

The Check Asset In function is used when an asset is returned to the default System
Location.

The System Owner (Custodian) and Location are displayed at the top. The system contact is
set to the default but can be changed if required.

 

The asset code to be checked in can then be entered (or scanned using a hand-held scanner).
The current details (before checking in) of the asset will be displayed, and the Custodian,
Location and Contact changed in the database to the system values.



Page56

AssetTracker User Guide V1.25.0                                                                   

© Barcode Logic Pty Ltd, 2017

 

For speed when checking in many assets to the same location, the Asset Code field is then
selected for the next item.

Note that an error will be displayed if the asset is already currently recording as being at the
System Owner and Location (you can't check it in if it's already here).

When an asset has been successfully checked in, the Add Alert button becomes active (if
alerts are enabled for this asset). If required you can then add an alert for this asset.

Either when the Print button is clicked, or when closing the Window*, and assets have been
checked in, the system will ask if you want to print a report of all assets checked in for that
session (i.e. Since the Check In window was opened).

* You can stop it asking if you want to print the report each time by unchecking the Prompt
to print check in and check out report each time option in the Asset Check Out Options.

The report printed will show the date and time, and a list of assets checked in together with
who they were checked in from and to.

If for example you check in 5 tools from Fred, he can take with him a hard copy of what he
returned.

A report on what was checked in by date and time can also be printed from the Main Menu -
select Reports / Assets Checked In.
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Reports

Reports can be printed from the main menu showing: 
Assets Checked Out and Assets Checked In by date and time range.
The default range is for the current day.

The report printed will show the date and time, and a list of assets checked out or in together
with who they were checked out or in from and to.

The report will look similar to this:

For options available when you preview any report, see Useful Tips.

An Assets Changed report is also available that lists all assets manually edited between two
dates.

The Assets not at the System Location report is most useful when using the system for
checking equipment in and out.
This report will show all assets currently checked out, i.e. not in the system location as
selected in Options / System Options.

The Assets not at the System Location by Product Group report is the same as the
Assets not at the System Location report but for only none product group.
You will be prompted to select a product group  first.
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Useful Tips

The data in this program is displayed mainly using 'Drop Down' Combo boxes and grids. This
is how they can be used as it is not always obvious:

Combo boxes

A 'combo box' provides a list of items that you can select from.
In this example it holds a list of the product groups. 

By clicking on the combo box, the full list of items to select from will drop down, allowing you
to select the one required. A scroll bar will appear if there are too many to display.

Alternatively, you can start typing in the box and the system will perform an 'incremental
search' and automatically move to the item closest to the one typed. Press ENTER to select it.

Grids

Most of the grids used in this system allow you to change the sort order of the data in the grid
by clicking on the column headers. This may help finding a particular record easier.

For example, this grid is sorted in ascending order of Product Code. By clicking on the Code
column header, the grid will display in descending order of Product Code.
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If you click on the Description column header, the grid will display in alphabetical order of
Product Description.

There are many ways to navigate around a grid such as using the arrow keys, page up / down
and home and end keys.
We also include a set of navigator buttons which perform similar functions:

The navigator also includes Search, Locate and Filter buttons which bring up appropriate
dialog boxes for displaying records by specific search criteria. 

The Locate dialog allows you to find one or more records by field value.
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First select the field name you want to search on from the drop down list at the bottom, select
the search type then enter the value you are searching for. Then click on First or next to find
records that match the criteria entered.

The Search dialog brings up all the records in the grid and allows you to do an incremental
search on the left-hand column. 
You can change the column order to search on a different column by dragging the column
heading to the left.
In this example, the Manufacturer field has been dragged to the left and an incremental
search done for the value 'ya'.

The Filter dialog is the most powerful and is used to limit the number of rows displayed in the
grid.
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In this example, all the assets are displayed in the grid. When the filter button is clicked, the
dialog appears.

The operator wants to display all assets currently the responsibility of Aardvark Security, so
they select Custodian Name as the field to filter on, enter the field value, select any other
options required and click on Ok.
Now only the Aardvark Security assets are displayed:
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Note that you can also enter a range of values.
Now if you click on Print All Labels or Print Asset List, only those assets currently
displayed in the grid will be printed.

To redisplay all the records in the grid, click on Show All.

Report Toolbar

When previewing any report, a toolbar is displayed at the top:

Most of these options are self explanatory, but two are particularly useful. These are:

    Export to PDF

When you click on this, two dialogs will open. 
The first gives you some PDF options and allows to to select particuler pages of the report.
The second will prompt you for the path and filename where you want to save the file.
The path will default to the Default Export Path as set in Options.
A default filename is provided, but you can change this to whatever to like.

    Send by E-mail

This option will create a PDF file of the report and send it to an E-mail recipient of your
choice.
A dialogue will appear with two tabs: 

The Account tab is for the details of the sender. 
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In the Connection section, enter you outgoing email account details. These will probably be
the same as for your default email client.
If you check the Remember properties box, these details will be remembered so you do not
need to enter them each time.

The email tab is for the details of the recipent. Once the recipent is entered, the system will
keep their details so they can be selected from the drop down list if required in future.
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When you click on OK, the PDF options dialog will open.
Select the required options, click on OK and the report will be created as a PDF file and
emailed.
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Deleting and Undeleting

In most cases, when you Delete data in AssetTracker, it is not actually deleted, just marked
as deleted.
It is important for the historical asset information that any old custodian and location
information etc. is kept.

If you check the Show Deleted check box, the deleted records will be displayed in Grey:

This allows you to see what has previously been deleted, and also to Undelete a record if
necessary (perhaps if it had been deleted in error).
When deleted records are displayed, and a deleted record is selected, the Undelete button is
enabled.

 



Page68

AssetTracker User Guide V1.25.0                                                                   

© Barcode Logic Pty Ltd, 2017

Label Printing

Barcoded Labels may be printed for Assets, Custodians, Locations and Contacts.
These enable quick and accurate data entry.

On each of these screens there are buttons marked Print One Label and Print All Labels.
Print One Label will print one for the currently selected record in the grid.
Print All Labels will print one for each record displayed in the grid. 
Note that if you do not want to print them all, you can filter the grid to reduce the number of
record shown (see Useful Tips) or, if you have Preview Before Printing turned on in
Environment Options, you can use the standard Windows print dialog to select which labels to
print.

The system was designed to use a Zebra TLP2844 Label Printer, but should work fine with
other label printers using continuous media that have MS Windows drivers.

In Environment Options, it is possible to select a label size. There are three options:

35mm x 17mm
50mm x 25mm
100mm x 19mm

Which label size you use depends on the number of characters being printed in the barcode,
and whether they are Numeric or Alphanumeric.
AssetTracker uses the Code 128 barcode type which creates a compact barcode and requires
less space for numeric codes than alphanumeric codes.

The best way to find out is by trial and error - turn on Preview Before Printing in
Environment Options
Then try printing a label. You will be able to see on screen if the barcode fits on the label. 
You must leave about 3mm of white space at the end of the barcode to be sure it reads
correctly.

This is a 35mm x 17mm label and it just holds a 7 character alphanumeric code.

This is a 35mm x 17mm label and it is much too small for the 13 character alphanumeric
code.

But this code fits (just) on a 50mm x 25mm label:
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A 13 character numeric code requires less space:

These codes should be long enough, although some people like to put a description in the
barcode, this makes for a very long code, which makes it harder to read and is NOT
recommended:

Remember that a seven digit alphanumeric code gives you 78,364,164,096 unique codes.
How many do you need?
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Import Asset User Fields From File

This function is found under File on the main menu.

It allows you to import some asset information from a CSV (Comma Separated Value file)
that may have been created using MS Excel or some other system.

The asset record must already have been created within AssetTracker.
The only fields that can be updated are the 14 user definable data fields for each asset.

The file to be imported must have a .CSV or .TXT extension.

Each record in the file can contain up to 15 fields, the Asset Code followed by the 14 values
for the user data fields.

e.g.

00000001,Garage Nb 1,25,Back Door,Red,,,,,,,,,,
00000002,Hanger 35,2,,Blue,,,,,,,,,,
00000099,Office,1,,,,,,,,,,,,
00000003,Garage Nb 2,5,Roller Door,Green,,,,,,,,,,

Note that some fields can be empty, but the asset code (first field) must exist and must be in
the AssetTracker database.

From the File menu, select Import Asset User Fields From File
This window will appear:
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Now click on the Select and Import CSV File button. 
The default windows Open File dialog will appear so you can browse for the file you want to
import.

Select the file you want and click on Open. 
The file will be imported and the results displayed:
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In this case one of the assets was not on file, so could not be updated.
The other records were processed ok.

If you now look up the assets in the asset list, you will see that the user data fields contain
the imported data.
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Import Asset, Product and Product Type Data From File

This function is found under File on the main menu.
It allows you to import asset, product and product type data from another AssetTracker
system which has been exported using the Save As CSV function in the bottom right corner
of the Assets Window.
This function is primarily designed to transfer assets from one AssetTracker system to
another.
It effectively 'Checks In' a batch of Assets.

NB: This will replace, not add to a database of assets. 
When this function is run, any assets, products and product types as well as audit and
transaction data relating to those assets will be deleted from the database before the file is
imported.

Here is a step by step guide to transferring the assets from the source system to the
destination system.

On the source system:

1. Check Out The Assets
Use the Check Asset Out function to check out the assets required to the location of the
destination system.

2. From the menu at the top of the main window, go to Tools > Options > Environment
Options and make sure the Save Asset Grid Settings box is NOT checked.
If it was checked, uncheck it and click on OK, then close and reopen AssetTracker.
This is so the fields from the Assets grid are exported in the correct order.

3. Export The data using the Save As CSV function

From the Assets Window, use the filter button  to select only the assets you want to
export (which will most likely be all the assets for the location of the destination system,
unless you want to export them all).

Now click on the Save As CSV button . A Save As dialog will open to allow
you to select the name and location of the Export file.
By default the location will be as set in Tools > Options > Environment Options > Default
Export Path.
By default, the Filename will be AssetListing.csv

This file is now ready for import into the destination system.

On the destination system:

1. Go to Tools > Options > System Options and make sure the System Owner, Location
and Default System Contact are correct, as when the Assets are imported, they will all be
assigned these values as they are checked in.

2. From the File menu, select Import Asset, Product and Product Type Data From File.
This window will appear:
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Now click on the Select and Import CSV File button.
You will be warned twice that this will delete any existing data and twice given the option to
cancel.
Then the default Windows Open File dialog will appear so you can browse for the file you
exported from the source system.
By default the starting location will be as set in Tools > Options > Environment Options >
Default Import Path.

Select the file and click on Open. 
The file will be imported and a dialog box displayed:

The Window will show how many Assets were added.
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If you now go to the Assets windows, the newly imported assets will be displayed.
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Select Database

Select Database

This function is found under Database on the main menu.

The AssetTracker system uses an MS Access Database (.MDB) file.

By default on installation, this file is called AssetTracker.mdb and is found in the
C:\Program Files\AST\AssetTracker directory.

If you need to share this database with another AssetTracker user, you may want to move it
to a file server (manually using Windows Explorer) then use this function to select it from its
new location.

When you click on Select Database, this window will appear which shows you the current file
and location:

Click on the button with the picture of the hand, and the standard Windows Open File dialog
will appear to allow you to select the new database file.

When you use this function to select a different database, you will automatically be logged off
and prompted to log on again.
This is because the operator list is stored in the database, and may be different in different
databases.

Using Multiple Databases

It is possible to use different database files for different asset groups.
Maybe you want to keep your register of computers separate from your furniture register or
you have two companies that require separate asset registers.

In the default installation directory (C:\Program Files\AST\AssetTracker) is an empty
database called AssetTracker_Empty.mdb.

You can manually copy and rename this file (using Windows Explorer) to something
meaningful such as AT_Company1.mdb and AT_Company2.mdb.

You can then use the Select Database function to switch between them as required.

If using more than one database, be careful not to confuse databases and enter data in the
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wrong one.

Backup The Database

It is important to know where your AssetTracker database file is and back it up regularly.
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PDT Functions

The PDT (Portable Data collection Terminal) functions of AssetTracker allow you perform
some of the system functions away from the PC.

On the PC, the three functions relating to the PDT are

Send Data To PDT

This function transfers the asset list and other data from the Database to the PDT.
When any asset barcode is scanned by the PDT, it can lookup the asset information on file
and display it. This is important for auditing, Checking Out or In.
See Sending Data to the PDT for details.

PDT Asset Audit

This is the most commonly used PDT function. This allows you to go to a location and scan all
the assets found in that location.
The PDT will indicate if the assets are on file, not on file or in the wrong location.
The database can be updated with the results of this audit.
See PDT Asset Audit for details.

PDT Check In/Out

The PDT can also be used to Check Assets Out and In, in a similar way to how it is performed
on the PC.
The data should be periodically uploaded from the PDT and applied (committed) to the
database.
See PDT Check In or PDT Check Out for details.

Note: Because the PDT is an 'off-line' or 'batch' device (i.e. not directly connected to the
database), it is important that changes are not made to the same asset on the PC and on the
PDT at the same time (i.e. between loading the file to the PDT and uploading and committing
the results).
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Programming the PDT

Normally, the PDT will already be programmed and running, if however it needs
reprogramming, perhaps because a new version of the software has been released, please
follow these steps:

Place the PDT in its cradle, and make sure it is turned on.

Select the Tools /  Download Program to PDT option from the main menu.

The program installation file will be copied to the PDT.

If there appears to be no communication with the PDT (for example the message 'CE Device
Not Connected' appears), please refer to the CE PDT Installation Guide for possible
solutions.

When the program has copied across, you will need to cold boot the PDT (also known as a
hardware reset) to install the new software.

See How to Cold Boot a PDT
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Setting the PDT Clock

The time is displayed on the PDT in the title bar on the main menu.

The program uses the PDT clock to record the date and time of each transaction, so it is
important that it is correct.

You can set it by selecting 'Tools / Set  PDT Clock' from the main menu. 
Be sure that the PDT is connected to the PC. 
The PDT clock will be set to the system time of the PC.
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Using The PDT

General Operation

1. Power

To use the Datalogic Memor PDT, it must be turned on, so let's start there:

After a short time, the PDT display backlight will turn off to save the display.
To turn the backlight back on, press the SCAN key.

After a longer period of time, the PDT will turn itself off completely. To turn it back on, press
the power button on the left hand side.

2. The Keypad

The Windows CE based Memor PDT has a touch screen and a keypad.

The program has been written to allow the operator to use the keyboard for almost all
operations. This allows the PDT to be used with one hand and without the need for a stylus.

The program can be operated using only these keys:

Esc - to go back a step or return to the previous screen (and eventually back to the main
menu).

Ent - to accept a number value that has been keyed in.

The alpha-numeric pad - for entering item codes and menu options

ALPHA - The ALPHA key changes the keypad from Numeric to Alpha mode and back. 
When the ABC icon is shown, the meaning of the keys is shown by the orange letters written
on the PDT keys.

When the 123 icon is shown, the meaning of the keys is shown by the white text written on
the PDT keys.
An indicator at the top of the screen shows whether the keyboard is in Alpha or Numeric
mode.

If you need the yellow characters or functions printed on the PDT next to the keys, press the
key with the yellow dot on it (botton right).
The indicator will look like this:

If you need the blue characters or functions printed on the PDT next to the keys, press the
key with the blue dot on it (botton left).
The indicator will look like this:
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Remember that the easiest way to enter data is to scan a barcode. If your barcode won't scan
it may be damaged so print a new one.

To select a menu item, either use the Arrow Keys to scroll through the menus then press
Enter when the required item is highlighted, or just press the number key corresponding to
the require item.

3. Dialogs

Whenever a dialog box appears with a question or error message, use the arrow keys to
select which option you want (if there is an option) and press Enter to select and close the
dialog.
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Sending Data to the PDT

This function downloads the asset list and other data to the PDT .

Important: The PDT program must be at the main menu for the data files to upload
successfully. 

Make sure the PDT is turned on.
Connect the PDT to the PC using the USB cable (or place the PDT in its cradle if you are using
one).
The PDT should connect to the PC, and the ActiveSync icon on the task tray of a Windows XP
or 2000 PC will go green.
The PDT will make a distinctive noise to indicate it has connected ok.

If it fails to connect, disconnect and reconnect it. If it still fails, please refer to the CE PDT
Installation Guide for possible solutions.

When connected, click on the Send Data to PDT button on the main screen of the PC.

The files will be created from the database and then transferred.

When completed Ok, a dialog will indicate this:

This message usually indicates that the PDT is not properly connected:
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This message usually indicates that a file is open on the PDT because it is not at the main
menu, so press ESC on the PDT until the main menu is displayed:
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PDT Main Menu

To select an option from the main menu, either:

1. Use the Joystick to scroll through the options and press ENTER, or
2. Press the numeric key corresponding to the option you want (1,2,3,4 or 5), or
3. Use you finger on the touchscreen.

The About button shows software and hardware version numbers.

The current time is displayed at the top, and to the right of that is the keyboard status
indicator. See General Operation for an explanation of this.

At the bottom of the screen, is a status bar showing the current state of charge of the battery.
In the example above, it is connected to the power so indicates that it is rechaging.
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PDT System Menu

The system menu has three functions:

Options allows you to change the way the Asset Audit function works. See PDT Options and
PDT Asset Audit for details.

Set Clock will allow you to set the date and time of the PDT clock. Note that the clock is set
in the PDT to the date and time of the PC it is connected to, each time the data is sent to the
PDT. 

Delete All Data will delete all data files from the PDT which includes all files sent to the PDT
from the PC, and any Audit, Check Out or Check In files that have been created on the PDT
but not uploaded yet.
This is useful if you have been using the PDT for testing, demonstration or just want to be
sure it is clear of all old data before starting an audit.
You will be prompted three times to confirm that this is really what you want to do.

About will show hardware and software version information
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PDT Options

These options affect the way the functions work on the PDT.
There two tabs of options, one for options that affect the Audit function, and another for the
Asset Check Out function

Audit

Prompt for Custodian Code.
During a PDT Asset Audit, you need to select the Custodian you are auditing. 
If this option is checked, then you can scan the custodian barcode (or manually type the
code) which is the quickest way to enter the data.
If you are not using custodian barcodes, you can leave this option unchecked and you will be
present with a list of all the custodians, and you can select the required one.

Prompt for Location Code.
During a PDT Asset Audit, you need to select the Location you are auditing. 
If this option is checked, then you can scan the location barcode (or manually type the code)
which is the quickest way to enter the data.
If auditing regularly, you may want to have a location barcode stuck on the wall of the
location so you don't need to select it each time.
If you are not using location barcodes, you can leave this option unchecked and you will be
present with a list of all the locations for the custodian selected, and you can select the
required one.

Prompt for Free Text when adding new assets.
During an audit, if an asset is not found on file, you will be asked if you want to add it. If this
option is checked then the PDT will prompt you to enter some text. 
When the data is later uploaded to the PC, and the asset added to the database, this text will
placed in User Assigned Field 8 of the asset record.
Note that this option is called Prompt for Free Text, but the words Free Text will be replaced
by whatever you have called Field 8 in Options.

Prompt for Product Code when adding new assets.
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As with the Prompt for Custodian and Location code options, this allows you to turn off the
prompt and just select from the list of available products.

Prompt for Condition
If this option is checked, during an audit you will be prompted to select the condition of the
asset from the list of conditions.
The condition of the asset will be changed to whatever was selected when the data is
uploaded to the PC.
Also, if the Prompt for Additional Info box is checked for the condition selected, you can
also enter some text on the PDT during the audit to better describe the condition.
When the audit data is uploaded, this text will be transferred to the User Assigned Field 7 of
the asset record.

Prompt to Add an Alert
If this option is checked, then during an audit you will be asked if you want to add an alert for
the asset scanned, and be prompted to select one from a list of available Alert Types. 
Press ESC if you don't want to add one or select one from the list and press ENTER.
Then asked to enter the date of the alert. 
This may be useful if the asset needs repairing or replacing for example.
The alert will be added to the database when the data is uploaded to the PC. 

Check Out

Use default contact location
By default, when checking out an asset, the PDT will ask the operator to select the custodian,
location and contact that the asset is to be checked out to.
If this option is checked, the PDT will prompt for the contact, will work out the custodian and
use the default location for the contact (see Contacts). 
Use this if the contact has only one location to save time.

Prompt for Reference
By default, when checking out an asset, the PDT will ask the operator to select a reference
(maybe for a particular job). If you do not need a reference, uncheck this box.
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PDT Asset Enquiry

After asset data has been sent to the PDT, this function can used to see if an asset is on file,
and display its details if so.

Either SCAN an asset barcode or key it in and press ENTER.

If the asset is not found on file, it will indicate this:

If found, the details will be displayed:

To see more information regarding this asset, use the Joystick to scroll through the 8 pages
of information available, for example:
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Press ESC to return to the main menu.
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PDT Asset Audit

The audit function allows you take the PDT to a location and scan all the assets in turn.
The PDT will indicate if the asset is not on file (and add it if required), is in the correct
location, or is in the wrong location (and allow you to change the location if required).

The date and time of each asset scan is stored, together with the operator code. 
This information is later upload to the PC and the database updated.
Each scan is added to the history of the asset, so it is possible to see later when the asset was
last seen.

Firstly, the PDT will prompt for the operator code:

You can either SCAN an operator barcode, type in the code and press ENTER, or press F1 to
select from the list of operators on file:
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Use the Joystick to move to the required record and press ENTER.
Up - takes you to the previous record
Down - takes you to the next record
Left - takes you to the first record
Right - takes you to the last record

After confirming the Operator:

the PDT will prompt for the custodian (if Prompt for Custodian Code is checked in PDT
Options). 
In the same manner, SCAN, Key or select and confirm the Location you are auditing:
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the PDT will then prompt for the location (if Prompt for Location Code is checked in PDT
Options). 
In the same manner, SCAN, Key or select and confirm the Location you are auditing:

If you enter a location code that does not exist, you will be asked if you want to add it:
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If you decide to add it, you will be prompted to enter the location name:

 

Type in a description on the keypad or use the on-screen keyboard to enter a name, then
press ENTER.
Note that if the Prompt for Location Code is not checked in PDT Options you cannot add a
location.

You are now ready to start scanning assets:
 
SCAN the asset barcode or type in the asset code and press ENTER.

If the asset is found on file and is in the correct location, the screen will be green and
will display the asset details. 
As in the PDT Asset Enquiry Function, you can use the joystick to scroll through the
information relating to this asset.
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A record is stored recording the fact that the asset was scanned.

If the asset is found on file but is in the wrong location, you will be asked if you want to
change it to the current location:

If you say no, it will not be changed, but will be recorded as having been scanned in the
wrong location.
If you say yes, the location will be changed and will be recorded as having been changed.
After this you can review its current details.

If the asset is not found on file, you will be asked if you want to add it.

If you say yes, you will be prompted to enter more information.
Firstly, if the Prompt for Free Text option is checked (see PDT Options), you will be
prompted to type something relating to the asset and press ENTER. 
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The Show Keyboard button will bring up the on screen keyboard for use with a stylus. This
may make entering a lot of data easier.
If you don't want to enter anything, just press ENTER.
Pressing ESC will abort the adding of the asset.
This data will be uploaded later and placed in User Field 8 of the asset database. 

Next you will be prompted to select the product group that this asset belongs to:

Use the arrow keys to select the correct group and press ENTER.
Pressing ESC will abort the adding of the asset.

Next you will be prompted to select the product that this asset is (if Prompt for Product
Code is checked in PDT Options):
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Use the arrow keys to select the correct group and press ENTER.
Pressing ESC will abort the adding of the asset.

Next, if Prompt for Condition is checked in PDT Options, you will need to select a condition
from the list available (see Asset Condition).

Use the arrow keys to select the correct group and press ENTER.
Pressing ESC will abort the adding of the asset.

Finally,  if Prompt to Add an Alert is checked in PDT Options, you may select an alert type
from the list available (see Alert Types).
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Use the arrow keys to select the alert type and press ENTER.
If you do not want to add an alert, press ESC. Note that this will not abort the adding of the
asset, just skip adding an alert.

If you did add an alert, you will then be prompted to enter the date for the alert.
It will default to the current date.

Press ENTER to accept the current date or type the date and press ENTER.
Pressing ESC will abort the adding of the asset.

The PDT will now return to the Asset prompt for scanning the next asset.

When auditing of the current location is finished, press ESC to return to the main menu, then
either audit another location or return the PDT to the PC to upload the data.
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Select PDT Asset Audit from the PC main menu.
Connect the PDT to the PC with the USB cable, make sure the PDT is at the Main Menu and
click on the Receive data from PDT button.
If the data transfers ok, an 'Import Report' window will display. Close it, and the data
received from the PDT is displayed in a grid:

The data is deleted automatically from the PDT after it has been successfully uploaded.

This data is stored in a separate database table until committed.
This allows you to review the data before applying it to the main asset register.

Click on Commit to apply the changes to the main database. 
You will be prompted that this is really what you want to do before changes are applied.

Each scan record will be added to the asset history, locations changed for those that required
this, and new assets added.

A summary will be displayed showing the results. This can be printed if required.
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Important Note: In rare cases transactions may not be processed. This is because between
the time an asset was audited and the audit data committed, the asset record in the database
had been changed on the PC. Because of this the earlier transaction was discarded, and the
later one assumed to be correct. Please try to avoid this situation.

The Delete All button allows you to delete all this data without applying it to the main
database, in case you have changed you mind, or were just testing.

Every file of data transferred from the PDT is stored on the PC as backup. The filename
contains the date and time that is was uploaded.
The Re-Import Uploaded List button, allows you to select one of these files and re-import it
back into this grid. This may be useful in an emergency.

To produce a report for items by location, you can select Assets from the main menu on the
PC, and filter the asset grid by Location or Custodian.
You can see from the Last Modified Date, which assets were not audited, and therefore
missing.
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PDT Check In

The PDT Check In function can be used to return Assets to the custody of the System Owner,
Location and Contact.

Firstly, as with the PDT Asset Audit, the PDT will prompt you to enter the Operator code or
select from a list then confirm that the date and time on the PDT is correct.

After that process, you can start scanning Assets.

If the asset is on file, and has been processed ok, the screen will be green and will display the
asset details. 
As in the PDT Asset Enquiry Function, you can use the joystick to scroll through the
information relating to this asset.

If the item is not on file, it will tell you:
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If the item cannot be checked in because it is already recorded as being at the System
Location, then message will be displayed:

When Checking In or Out (or both) has been completed, select PDT Check In / Out from the
PC main menu.
Connect the PDT to the PC with the USB cable, make sure the PDT is at the Main Menu and
click on the Receive data from PDT button.
If the data transfers ok, an 'Import Report' window will display. Close it, and the data
received from the PDT is displayed in a grid:
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The data is deleted automatically from the PDT after it has been successfully uploaded.

This data is stored in a separate database table until committed.
This allows you to review the data before applying it to the main asset register.

Click on Commit to apply the changes to the main database. 
You will be prompted that this is really what you want to do before changes are applied.

Each record will be added to the asset history and locations changed to the System Location
in the database.

A summary will be displayed showing the results. This can be printed if required.

Important Note: In rare cases transactions may not be processed. This is because between
the time an asset was audited and the audit data committed, the asset record in the database
had been changed on the PC. Because of this the earlier transaction was discarded, and the
later one assumed to be correct. Please try to avoid this situation.
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The Delete All button allows you to delete all this data without applying it to the main
database, in case you have changed you mind, or were just testing.

Every file of data transferred from the PDT is stored on the PC as backup. The filename
contains the date and time that is was uploaded.
The Re-Import Uploaded List button, allows you to select one of these files and re-import it
back into this grid. This may be useful in an emergency.
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PDT Check Out

The PDT Check Out function can be used to issue Assets from the System Owner, Location
and Contact to another Custodian, Location and Contact.

Firstly, as with the PDT Asset Audit, the PDT will prompt you to enter the Operator code or
select from a list.
Next, by default *, in a similar manner it will prompt for the new Custodian, Location and
Contact.

* If the Use default contact location option is checked in Options, then it will only prompt
for the Contact. In this case it will work out who the custodian is and use the default location
and use the default location assigned to the contact (see Contacts).

Then it will ask for a reference which can be selected from the list of available references
created on the PC. See Asset Reference for details.
If no reference is required, just press ENTER to Accept 'No Reference'. 

If a reference is never required, you can stop it asking by unchecking the Prompt for
Reference option in Options.

finally, you can start scanning Assets.

If the asset is on file, and has been processed ok, the screen will be green and will display the
asset details. 
As in the PDT Asset Enquiry Function, you can use the joystick to scroll through the
information relating to this asset.
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If the item is not on file, it will tell you:

If the item cannot be checked out because it is already recorded as being at the new Location
you have selected, it will indicate this:
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If the item cannot be checked out because it is not recorded as being at the System Location,
then message will be displayed:

When Checking In or Out (or both) has been completed, select PDT Check In / Out from the
PC main menu.
Connect the PDT to the PC with the USB cable, make sure the PDT is at the Main Menu and
click on the Receive data from PDT button.
If the data transfers ok, an 'Import Report' window will display. Close it, and the data
received from the PDT is displayed in a grid:
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The data is deleted automatically from the PDT after it has been successfully uploaded.

This data is stored in a separate database table until committed.
This allows you to review the data before applying it to the main asset register.

Click on Commit to apply the changes to the main database. 
You will be prompted that this is really what you want to do before changes are applied.

Each record will be added to the asset history and locations changed to the System Location
in the database.

A summary will be displayed showing the results. This can be printed if required.

The Delete All button allows you to delete all this data without applying it to the main
database, in case you have changed you mind, or were just testing.

Every file of data transferred from the PDT is stored on the PC as backup. The filename
contains the date and time that is was uploaded.
The Re-Import Uploaded List button, allows you to select one of these files and re-import it
back into this grid. This may be useful in an emergency.
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How to Cold Boot a PDT

A cold boot is a hardware reset of the PDT. It should only be done after installing new
software or if some problem has occurred with the PDT and only after all other possible
solutions have been attempted.
If you need to do it, we would be interested to know why, and if it solved the problem.

Before doing a cold boot, make sure the PDT program is displaying it's main menu, this
should eliminate any chance of data being lost.

A cold boot is performed by pressing a series of keys on the PDT. 

On the Datalogic Memor, press the down vertically on the Joystick, press the ESC key, then
the POWER button on the side simultaneously, the screen should go blank.

On the Datalogic Memor X3, press the ESC key, ENT key then the POWER button at the top
left of the screen simultaneously, the screen should go blank.

After pressing these keys it may take up to a minute for the PDT to return to the main menu.
Be patient and do not press any other keys until the main menu is displayed.
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AssetTracker CICO Client

The Asset Tracker Check Out / Check In Client has been added as a separate program to
simplify the process.
The main AssetTracker program must be installed first.

This application has a main menu:

After installation, use the Database > Select Database function to connect to the same
database that the main AssetTracker program is using. 
This will most likely be on a network server.

After connecting to the database, go to Tools > Options and log on. You will need to be an
AssetTracker administrator to get access to this function.
Set the System Owner, Location and Contact. In most cases this will be the same as is set
in the main AssetTracker options.

Now you can use the two main functions to check assets out and in.

Check Asset Out
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This function is similar to the normal Check Asset Out function but simplifies the data entry.
Only one asset can be checked out at a time. Do do this:

Scan the operators barcode (the person doing the checking out).
The operator must be Level 3 or above to check asset in or out (see Operators).
Note that the operator password is not required so consider this when assessing the

risk of using the CICO Client Application. 

Scan the contacts barcode (the person the asset is being checked out to).
The contact must be different from the operator (you can't check an asset out to

yourself).

Scan the asset barcode (the asset being checked out).
The asset will be checked out to the default location for the contact, so the contact

must have a default location set (see Contacts).
If the asset has active Alerts, you will be asked if you want to display them, but you

cannot edit or delete them. 
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If all is well, a dialog will show that the asset was checked out ok.

Check Asset In

This function is similar to the normal Check Asset In function but simplified.
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Only one asset can be checked in at a time. Do do this:

Scan the operators barcode (the person doing the checking out).
The operator must be Level 3 or above to check asset in or out (see Operators).

Scan the asset barcode (the asset being checked out).
The asset will be checked in to the System Owner, Location and Contact set in

Tools > Options.
If the asset has active Alerts, you will be asked if you want to display them, but you

cannot edit or delete them. 

 If all is well, a dialog will show that the asset was checked in ok.
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